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Pentaho Data Integration (PDI) is a an extract, transform, and load (ETL) solution that uses an innovative metadata-
driven approach. It includes an easy to use, graphical design environment for building ETL jobs and transformations,
resulting in faster development, lower maintenance costs, interactive debugging, and simplified deployment.
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Common Uses
Pentaho Data Integration is an extremely flexible tool that addresses a broad number of use cases including:

« Data warehouse population with built-in support for slowly changing dimensions and surrogate key creation

« Data migration between different databases and applications

» Loading huge data sets into databases taking full advantage of cloud, clustered and massively parallel processing
environments

« Data Cleansing with steps ranging from very simple to very complex transformations

« Data Integration including the ability to leverage real-time ETL as a data source for Pentaho Reporting

» Rapid prototyping of ROLAP schemas

« Hadoop functions: Hadoop job execution and scheduling, simple Hadoop MapReduce design, Amazon EMR
integration

Key Benefits
Pentaho Data Integration features and benefits include:

« Installs in minutes; you can be productive in one afternoon

* 100% Java with cross platform support for Windows, Linux and Macintosh

« Easy to use, graphical designer with over 100 out-of-the-box mapping objects including inputs, transforms, and
outputs
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Simple plug-in architecture for adding your own custom extensions

Enterprise Data Integration server providing security integration, scheduling, and robust content management
including full revision history for jobs and transformations

Integrated designer (Spoon) combining ETL with metadata modeling and data visualization, providing the perfect
environment for rapidly developing new Business Intelligence solutions

Streaming engine architecture provides the ability to work with extremely large data volumes

Enterprise-class performance and scalability with a broad range of deployment options including dedicated,
clustered, and/or cloud-based ETL servers
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Pentaho Data Integration Architecture

The diagram below depicts the core components of Pentaho Data Integration Enterprise Edition.

Spoon Browser
Client
H t
; _ ; :
EE Data Integration Server

Spoon is the design interface for building ETL jobs and transformations. Spoon provides a drag and drop interface
allowing you to graphically describe what you want to take place in your transformations which can then be executed
locally within Spoon, on a dedicated Data Integration Server, or a cluster of servers.

Enterprise Edition (EE) Data Integration Server is a dedicated ETL server whose primary functions are:

Execution Executes ETL jobs and transformations using the Pentaho
Data Integration engine.

Security Allows you to manage users and roles (default security) or
integrate security to your existing security provider such
as LDAP or Active Directory

Content Management Provides the ability to centrally store and manage your
ETL jobs and transformations. This includes full revision
history on content and features such as sharing and
locking for collaborative development environments.

Scheduling Provides the services allowing you to schedule activities
and monitor scheduled activities on the Data Integration
server from within the Spoon design environment.

The Enterprise Console provides a thin client for managing deployments of Pentaho Data Integration Enterprise
Edition including management of Enterprise Edition licenses, monitoring and controlling activity on a remote Pentaho
Data Integration server and analyzing performance trends of registered jobs and transformations.
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Downloading Pentaho Data Integration

Before you begin to download Pentaho Data Integration, you must have Java 6.0 already installed.

1. Go to the Pentaho Product Download page.
2. Select the appropriate operating system requirements.

Note: The installation instructions in this document are based on the Windows Operating System
| exclusively.

3. Fill out the contact form and click Send. Your download starts automatically.


http://www.oracle.com/technetwork/java/javase/downloads/jdk6-jsp-136632.html
http://www.pentaho.com/download/
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It is assumed that you will follow the default installation instructions and that you are installing to a local device
(localhost).

1. Read and accept the License Agreement.

2. Specify the location where you want to install Pentaho Data Integration or click Next to accept the default.

3. Set the user name and password for the Administrator account. For the purposes of this evaluation, accept the
default user name, "admin," and type "password" in Password and Confirm Password fields.

4. Click Next to accept the default installation options on the Summary page.
5. Click Next to begin installation.

Pentaho Data Integration is installed as a Window service. When installation is complete, the Spoon designer is
launched.

If you inadvertently exit Spoon, follow the instructions below to launch it again.
1. Navigate to the folder where you have installed Pentaho Data Integration; for example c:\Program Files\pentaho
\design-tools\data-integration.
2. Double-click Spoon.bat to launch the designer.
Note: If you are using Linux, double-click spoon.sh. To start the Spoon Designer on a Mac, goto. ../

| pdi - ee/ dat a- i nt egr ati on and double click on the Data Integration 32-bit or Data Integration 64-bit
icon depending on your system.

3. Alternatively, in Windows, go to Start -> Pentaho Enterprise Edition -> Design Tools to launch the designer.

Follow the directions below to start the DI Server.

1. Navigate to the Pentaho Data Integration installation directory.
cd c:\Program Fi |l es\ pent aho\ server\data-i ntegration-server\

2. Run the start-pentaho.bat script to start the DI Server.

3. Alternatively, you can use the Start menu. Go to the Server Control section of the Pentaho Enterprise Edition
Start menu folder, then click on Start Data Integration Server.

After installation, your pentaho folder contains the following files and directories:

File/Folder Name Description
\design-tools\data-integration Contains the Spoon designer and command line utilities
\server\data-integration-server Contains the data integration server including individual

start/stop scripts; contains the enterprise console server
including individual start/stop scripts

\design-tools\docs\English Contains this document

\server\data-integration-server\ start-pentaho.bat Script file for starting the Data Integration server on
Windows

\server\data-integration-server\ start-pentaho.sh Script file for starting the Data Integration server on Linux

and Macintosh
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File/Folder Name Description

\server\data-integration-server\ stop-pentaho.bat Script file for stopping the Data Integration server on
Windows

\server\data-integration-server\ stop-pentaho.sh Script file for stopping the Data Integration server on Linux
and Macintosh

\design-tools\data-integration\Spoon.bat Script file for starting the Spoon Designer on Windows

\design-tools\data-integration\spoon.sh Script file for starting the Spoon Designer on Linux and
Macintosh

Before you can connect to a data source in any Pentaho server or client tool, you must first install the appropriate
database driver. Your database administrator, Chief Intelligence Officer, or IT manager should be able to provide

you with the proper driver JAR. If not, you can download a JDBC driver JAR file from your database vendor or driver
developer's Web site. Once you have the JAR, follow the instructions below to copy it to the driver directories for all of
the Business Analytics components that need to connect to this data source. See the Compatibility Matrix: Supported
Components in any of the Installation guide for current version numbers.

Note: Microsoft SQL Server users frequently use an alternative, non-vendor-supported driver called JTDS. If
you are adding an MSSQL data source, ensure that you are installing the correct driver.

Backing up old drivers

You must also ensure that there are no other versions of the same vendor's JDBC driver installed in these directories.
If there are, you may have to back them up and remove them to avoid confusion and potential class loading problems.
This is of particular concern when you are installing a driver JAR for a data source that is the same database type

as your Pentaho solution repository. If you have any doubts as to how to proceed, contact your Pentaho support
representative for guidance.

Installing JDBC drivers

Copy the driver JAR file to the following directories, depending on which servers and client tools you are using
(Dashboard Designer, ad hoc reporting, and Analyzer are all part of the BA Server):

Note: For the DI Server: before copying a new JDBC driver, ensure that there is not a different version of the
same JAR in the destination directory. If there is, you must remove the old JAR to avoid version conflicts.

 BA Server: / pent aho/ server/ bi server-ee/toncat/|ib/
« Enterprise Console: / pent aho/ server/enterprise-consol e/ j dbc/

- Data Integration Server: / pent aho/ server/ dat a-i ntegrati on-server/tontat/webapps/ pent aho-di/
VEB- | NF/ | i b/

e Data Integration client: / pent aho/ desi gn-t ool s/ dat a-i ntegration/li bext/JDBC/

* Report Designer: / pent aho/ desi gn-t ool s/ report -desi gner/1ib/jdbc/

« Schema Workbench: / pent aho/ desi gn-t ool s/ schema- wor kbench/ dri vers/

» Aggregation Designer: / pent aho/ desi gn-t ool s/ agg- desi gner/drivers/

« Metadata Editor: / pent aho/ desi gn-t ool s/ net adat a- edi tor/ 1 i bext/ JDBC

Note: To establish a data source in the Pentaho Enterprise Console, you must install the driver in both the
| Enterprise Console and the BA Server or Data Integration Server. If you are just adding a data source through
the Pentaho User Console, you do not need to install the driver to Enterprise Console.

Restarting

Once the driver JAR is in place, you must restart the server or client tool that you added it to.
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Connecting to a Microsoft SQL Server using Integrated or Windows Authentication

The JDBC driver supports Type 2 integrated authentication on Windows operating systems through the
integratedSecurity connection string property. To use integrated authentication, copy the sqljdbc_auth.dll file to all
the directories to which you copied the JDBC files.

The sqljdbc_auth.dll files are installed in the following location:

<installation directory>\sqljdbc_<version>\<l|anguage>\ aut h\

Note: Use the sqljdbc_auth.dll file, in the x86 folder, if you are running a 32-bit Java Virtual Machine (JVM)

| even if the operating system is version x64. Use the sqljdbc_auth.dll file in the x64 folder, if you are running a
64-bit JVM on a x64 processor. Use the sqljdbc_auth.dll file in the 1A64 folder, you are running a 64-bit JVM on
an Itanium processor.
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Connecting to the Enterprise Repository

Next, you will create a connection to the Enterprise Repository that is part of the Data Integration Server. The
Enterprise Repository is used to store and schedule the example transformation and job you will create when
performing the exercises in this document.

To create a connection to the Enterprise Repository:...

1. In the Repository Connection dialog box, click & (Add).

2. Select Enterprise Repository:Enterprise Repository and click OK.
The Repository Configuration dialog box appears.

3. Keep the default URL.

The URL used to connect to the Data Integration server is provided by default.

4. Click Test to ensure your connection is properly configured. If you get an error, make sure you started your Data
Integration Server .

5. Click OK to exit the Success dialog box.
6. Enter an ID and Name for your repository.

| Fikta: [ Nacalhast: 2030 Hertafo-d

e [Nacalhast Test I

| PRODUCTION-1

Marmns:
| Enterories Renasitery

7. Click OK to exit the Repository Configuration dialog box.
Your new connection appears in the list of available repositories.

8. Log on to the Enterprise Repository by entering the following credentials: user name = joe, password = password.

The Data Integration Server is configured out of the box to use the Pentaho default security provider. This has been
pre-populated with a set of sample users and roles including:

« Joe — Member of the admin role with full access and control of content on the Data Integration Server
* Suzy — Member of the CEO role with permission to read and create content, but not administer security

Note: See the Pentaho Business Analytics Security Guide available in the Pentaho InfoCenter for details
| about configuring security to work with your existing security providers such as LDAP or MSAD.
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Navigating through the Interface

The Welcome page contains useful links to documentation, community links for getting involved in the Pentaho Data
Integration project, and links to blogs from some of the top contributors to the Pentaho Data Integration project.

A ]
B e&EE Perspective: | [ Data Integraon | ) Model [ visualoe 1 Schedule
Welcoma!

B il I-h,#-i PRa@ 5 olwe v @

B — o ——{)

Walue Mapper

The Spoon Designer is organized into the components described in the table below:
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Component Name Description

1-Menubar The Menubar provides access to common features such
as properties, actions and tools

2-Main Toolbar The Main Toolbar provides single-click access to common
actions such as create a new file, opening existing
documents, save and save as. The right side of the

main toolbar is also where you can switch between
perspectives:

« Data Integration — This perspective (shown in the
image above) is used to create ETL transformations
and jobs

¢ Model — This perspective is used for designing
reporting and OLAP metadata models which can be
tested right from within the Visualization perspective or
published to the Pentaho BA Server

« Visualize — This perspective allows you to test
reporting and OLAP metadata models created in the
Model perspective using the Report Design Wizard
and Analyzer clients respectively

e Schedule — This perspective is used to manage
scheduled ETL activities on a Data Integration Server

3-Design Palette While in the Data Integration perspective, the Design
Palette provides an organized list of transformation

steps or job entries used to build transformations and
jobs. Transformations are created by simply dragging
transformation steps from the Design Palette onto the
Graphical Workspace, or canvas, (4) and connecting them
with hops to describe the flow of data.

4-Graphical Workspace The Graphical Workspace, or canvas, is the main design
area for building transformations and jobs describing the
ETL activities you want to perform.

5-Sub-toolbar The Sub-toolbar provides buttons for quick access to
common actions specific to the transformation or job such
as Run, Preview and Debug.

Pentaho Data Integration provides you with tools that include ETL, modeling, and visualization in one unified
environment — the Spoon interface. This integrated environment allows you, as Bl developer, to work in close
cooperation with business users to build business intelligence solutions more quickly and efficiently.
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When you are working in Spoon you can change perspectives, or switch from designing ETL jobs and transformations
to modeling your data, and visualizing against the data. As users provide you with feedback about how the data is
presented to them, you can quickly make iterative changes to your data directly in Spoon by changing perspectives.
The ability to quickly respond to feedback and to collaborate with business users is part of the Pentaho Agile Bl
initiative. See the Agile Bl Techcast series to learn more.

Perspective: | B3 Data Integration ['I Mol = visualize ) Schedue

There are four perspectives in Spoon, they include:

e The Data Integration (ETL)

*  Model

* Visualize

» Schedule (associated with the Data Integration perspective)

Each perspective is described in the sections that follow.

Instaview is a data integration transformation, a metadata model, and the means to visually analyze data using reports
and charts.

Instaview uses Pentaho Analyzer as the tool for exploring your data. Analyzer's drag-and-drop user interface makes it
easy to create interactive reports based on your data and enables you to drill down into the data to discover previously
hidden details. Instaview presents data multi-dimensionally and enables you to select what dimensions and measures
to explore. Use Analyzer to drill, slice, dice, pivot, filter, chart data, and create calculated fields.

Configure mode and View mode

You can switch to one of two modes within Instaview, Configure mode and View mode. Configure mode enables you
to edit an Instaview's configuration details. View mode is where reporting and analysis takes place.

Within View mode you are able to drag and drop data onto the Reporting canvas to interactively explore your data.
Instaview offers many ways to visually display data, such as maps, charts, and grids. You may have multiple Views
open for editing at a time, but you may only have one Instaview open at a time.


http://www.pentaho.com/events/201004_PDI4_AgileBI_techcast_series/
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Component Description

1 - Instaview A combination of a valid data connection, a data integration transformation, a
metadata data source template, and one or more Analyzer Views. You can only
have one Instaview at a time.

2 - View A tool for generating analysis content, such as reports and visualizations. A View
uses Pentaho Analyzer to help you explore and visualize your data through maps,
charts, grids, filters, and enables users to drill down into business information
contained in Instaview data sources.

3 - Available fields panel Displays fields within a connected data source.

» The thin yellow steps represent levels within the data hierarchy (text fields).
Levels are hierarchical groups of dimensions, which are facets of your data that
can be measured. For instance, within a time dimension there are different levels
of measurement such as year, quarter, month, or day.

« The blue carpenter squares represent measurements within the data hierarchy
(number fields). A measure is a facet of your data that can be quantified.
Measures are also referred to as facts.

4 - Layout panel Enables you to easily drag levels and measures into the correct areas of a report.
Displays which fields are in use within a View.

5 - Properties panel Enables you to configure report and visualization properties to customize analysis
content.

6 - Configure/View mode The Configure/View mode toggle allows you to switch between Configure mode

toggle and View mode.

« Configure mode enables you edit a data connection, data integration
transformation, metadata data source template, and Analyzer report. Also
provides the means to clear the Data Cache.

* View mode enables you to create reports and visualizations from a valid
Instaview data source. From within this view you can drag and drop fields from
(measurements or dimensions) your data onto the Reporting canvas.

7 - Filters toolbar Enables you to specify how your data is displayed based on user-defined values.
Applying filters changes the way the data is displayed in an Analyzer report or
visualization. You can also drag and drop levels or dimensions onto this toolbar to
filter your data.

8 - Report/Chart format toggle | Enables you to switch the format of your data as either a report or a chart.
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Component

Description

9 - Analyzer Report canvas

A graphical workspace that serves as the main design area for building Analyzer
reports with Instaview.

Within Configure mode you can access an Instaview's underlying configuration details.

Edit the data source

Edit the data integration transformation
Edit the metadata model

Clear the data cache

Open, delete, or rename existing Views
Create new Views

Run or refresh the Instaview data
Clear the data cache

Configure View

Configure 1 Visualizations

sV

4 Cick edt to modfy data nput ssttngs “

< Auto run Analysis when ready {Sample Size)

Data last refreshed - 10/5/12 11:46:00 AM

Component

Description

1 - Configure panel « The Edit button takes you to the data connection dialog and allows you to edit
the data connection settings for the current Instaview.

e The Auto run Analysis when ready option, if checked, will automatically create
a new Analyzer view after pressing Run.

* The Run button lets you manually start the Instaview data transformation.
Pressing Run will modify the data integration transformation or metadata model
if changes were made within the Configure panel, if necessary.

2 - Data Integration panel

Provides the means to access and edit the data integration transformation for the
current Instaview. Editing will open the Data Integration perspective in PDI.

3 - Metadata Model panel

Enables you to edit the metadata model for the current Instaview. Editing will open
the Model perspective in PDI.

4 - Data Cache panel

Provides the means to clear the data cache.

5 - Visualizations panel

Displays existing Instaviews and provides the means to open existing, create new,
and delete Instaviews. You can also rename an existing visualization by right-
clicking an item within this panel.

6 - Refresh display

Displays when the current Instaview was last run. If your data is connected to a live
data source this displays the last time the data was accessed by Instaview.
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Component Description

The Refresh button provides the means to manually refresh the current Instaview.

Supported formats and data sources
Instaview comes with pre-configured templates that give you instant connectivity to the most popular data sources.

« Local Files: Load existing Excel spreadsheets or CSV files.

« Relational Databases: Working with JDBC 3 compliant databases in Instaview enables you to analyze your data
even without in-depth knowledge of how your database is structured.

» Big Data: Cassandra, Hadoop, Hive, or MongoDB are easily integrated.
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Creating Transformations

The Data Integration perspective of Spoon allows you to create two basic document types: transformations and jobs.
Transformations are used to describe the data flows for ETL such as reading from a source, transforming data and
loading it into a target location. Jobs are used to coordinate ETL activities such as defining the flow and dependencies
for what order transformations should be run, or prepare for execution by checking conditions such as, "Is my source
file available?," or "Does a table exist in my database?"

This exercise will step you through building your first transformation with Pentaho Data Integration introducing common
concepts along the way. The exercise scenario includes a flat file (CSV) of sales data that you will load into a database
so that mailing lists can be generated. Several of the customer records are missing postal codes (zip codes) that must

be resolved before loading into the database. The logic looks like this:

| ) es i |
Read Sales Data —<_Zip Missing? I, Lockup Zip Code ———» Load Data

(o T

Retrieving Data from a Flat File (Text File Input Step)

Follow the instructions below to retrieve data from a flat file.

1. Click New in the upper left corner of the Spoon graphical interface.
2. Select Transformation from the list.

3. Under the Design tab, expand the Input node; then, select and drag a Text File Input step onto the canvas on the
right.

@& Spoon - [Pentaho Enterprise Repository] Transformation 1 (dis

Fie Edit View Acton Took Hep

2| glalal o
@ vew (OESGR SN WPOTROON 112 -
teps [ e |l e] o] m]®
il Get Fies Rows Count &
y Get SubFolder names
B, Get System Info
[ Google Analytics Input E‘l:
& Google Docs Input Teut file imput
W LDAP Input
W LDF Input
& Mondrian Input
& Property Input
Bl RSS Input
B 53 Csvinput
@& Salesforce Input
5L SAP Input
& Table nput
& Text fie input
JE xBasze input

ANy

4. Double-click on the Text File input step.

The edit properties dialog box associated with the Text File input step appears. In this dialog box, you specify the
properties related to a particular step.
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!:1 Text file nput ‘
Shen name
ﬁ“.__ﬁﬂnt:nt Error Handing | Fiters | Felds
File or drectory | L Mdl Browse
Regular Expresson |
Seectzd flest | g o | Flejowectary | wildeard (Regesn) | Bequired | Include subfolgers | {

Accept filerames from previous step [T

Pass through Fislds From previous step [
tep to read filenames I |

Apcapt flsnames fram prévious sisns

Show flename(s)... | Show fle content |  Shaw content from frst data ine |

gt gpamn, | e R ».JO' e

R

5. In the Step Name field, type Read Sales Data.
You are renaming the Text File Input step to Read Sales Data.

6. Click Browse to locate the source file, sales_data.csv, available at . . . \ desi gn-t ool s\data-i ntegration
\'sanpl es\transformati ons\files.
The path to the source file appears in the File or directory field.

7. Click Add.
The path to the file appears under Selected Files. You can look at the contents of the file by clicking the Show file
content to determine things such as how the input file is delimited, what enclosure character is used, and whether
or not a header row is present. In the example, the input file is comma (,) delimited, the enclosure character being a
guotation mark () and it contains a single header row containing field names.

8. Click the Content tab.
The fields under the Content tab allow you to define how your data is formatted.

9. Make sure that the Separator is set to comma (,) and that the Enclosure is set to quotation mark (). Enable
Header because there is one line of header rows in the file.

Breamema =¥

Stepname | Read Sales Data
Fie (CONEERE ™. Errar Handing | Filters | Fields |

Escape | "
-

Footer | TRIWCET O TOOLEr |'E“"1 1

virapped bnes? [T numbar of timas wr

Y WY rﬁ-wq-'“—-r‘ P XS

10.Click the Fields tab and click Get Fields to retrieve the input fields from your source file.
A dialog box appears requesting that you to specify the number of lines to scan, allowing you to determine default
settings for the fields such as their format, length, and precision. Type 0 (zero) in the Number of Sample Lines text
box to scan all lines. By scanning all lines, you ensure that Pentaho Data Integration has read the entire contents
of the file and you reduce the possibility of errors that may cause a transformation not to run. Click OK and the
summary of the scan results appears. Once you are done examining the scan results,click Close to return to the
step properties editor.
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11.Click Preview Rows to verify that your file is being read correctly. You can change the number of rows to preview.
click OK to exit the step properties dialog box.

TS

Rows of step: Read Sales Data (100 rows)
#~ | ORDERNUMBER | QUANTITYORDERED | PRICEEACH | ORDERLINENUMB... | SaLES | orDERDATE  [status | g I'-'It!
1 10107 30 95.7 2 2671 2/24/2003 0:00  Shipped 1

10121 34 B1.35 5 27659  5/7/20030:00  Shipped 2
3 10134 41 94.74 2 3884.34 | 7/1/20030:00  Shipped 3 '
4 10145 45 83.26 & 37467  §/25/2003 0:00 Shipped 3 Y
5 10159 49 100 14 5205.27 | 10/10/2003 0:00 Shipped 4
& 10168 36 96.66 1 3479.76  10/28/2003 0:00 Shipped 4
7 10180 29 86.13 § 2497.77 | 11/11/2003 0:00 Shipped 4
] 10188 45 100 1 5512.32  11/1B/2003 0:00 Shipped 4
9 10201 22 98.57 2 216854 | 12/1/2003 0:00  Shipped 4
10 10211 41 100 14 470B.44 | 1/15/2004 0:00  Shipped 1
11 10223 37 100 1 3965.66  2/20/2004 0:00  Shipped 1
12 10237 23 100 7 233312  4/5/20040:00  Shipped 2
13 10251 26 100 2 3188.64 | 5/18/2004 0:00  Shipped 2 ?
14 10263 34 100 2 3676.76  6/28/2004 0:00  Shipped 2
15 10275 45 92.83 1 4177.35  7/23/2004 0:00  Shipped 3
16 10285 36 100 6 4099.68 | 8/27/2004 0:00  Shipped 3
17 10299 23 100 9 2597.33 | 9/30/2004 0:00  Shipped 3
11 | »
- e

12.Save your transformation. See Saving Your Transformation on page 20.

Saving Your Transformation
Follow the instructions below to save your transformation.

Note: You can save your transformation at any point in this walk through. Saving allows you to start and stop
i the exercises at your convenience.

1. In the Spoon designer, click File -> Save As.
The Transformation Properties dialog box appears.

2. Inthe Transformation Name field, type Getting Started Transformation.

* X
Transformation . Parameters| Logaing | Dates | Dependencies | Miscellaneous | Monitoring
Transformation Name : | Getting Started Transformation
Transformation fiename
Description :
Extended description:
Status: [~
Version:
Directory :

Created by

OK ” SOL H Cancel |

3. In the Directory field, click (=] (folder icon) to select a repository folder where you will save your transformation.

Expand the Home directory and double-click the joe folder.
Your transformation will be stored in the joe folder in the Enterprise Repository.
5. Click OK to exit the Transformation Properties dialog box.
The Enter Comment dialog box appears.
6. Click in the Enter Comment dialog box and press <Delete> to remove the default text string. Type a meaningful
comment about your transformation.
The comment and your transformation are tracked for version control purposes in the Enterprise Repository.

7. Click OK to exit the Enter Comment dialog box.
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Filter Records with Missing Postal Codes (Filter Rows Step)

The source file contains several records that are missing postal codes. You will now use the Filter Rows transformation
step to separate out those records so that you can resolve them in a later exercise.

1. Add a Filter Rows step to your transformation. Under the Design tab, go to Flow -> Filter Rows.

2. Create a "hop" between the Read Sales Data (Text File Input) step and the Filter Rows step. Hops are used to
describe the flow of data in your transformation. To create the hop, click the Read Sales Data (Text File input) step,
then press the <SHIFT> key down and draw a line to the Filter Rows step.

SO NS R

-

= Y

Text file input Filter rows

Alternatively, you can draw hops by hovering over a step until the hover menu appears. Drag the hop painter icon
from the source step to your target step.

Note: For more information on hops including a description of color coding and hop icons, see the Pentaho
Data Integration User Guide in the Pentaho InfoCenter.

3. Double-click the Filter Rows step.
The Filter Rows edit properties dialog box appears.

4. In the Step Name field type, Filter Missing Zips.

5. Under The condition, click <f i el d>. A dialog box that contains the fields you can use to create your condition
appears.

=[E
Select a field: "
OADEANUMEER.  (Integer)
QUANTITYORDERED  (Infeger)
PRICEEACH (Humber)
CADERLMEMUMEER.  (Iritager) ’
SALES {(Mumber)
CADERDATE Date) '
" STATLIS
Brerrows =ng‘ am .
. MOMTH_ID i1 ":-
Step rame | Fiter Migsing Jips 4 YEAR_ID (Irteger)
Serd 'true’ data to | ' :f_'ﬁ""d_'nE .:[Ege ’ ‘l
nd 'false’ data to | PRODUCTCODE  (String)) "
CUSTOMERMAME  [Siring)
The condtion: PHONE (String)
ADDRESSLINEL  [String) -
ADDRESSLINEZ  (String) 4
[cfis® = | [cEield:] ) cImy (5éring])
J STATE Sk |1;:
| fosTascose *eng
COUNTRY (Siring)
‘ TERRITORY (Siring)
: COMTACTLASTMAME  [String) :
CONTACTFIRSTMAME  (String)
K10

6. Inthe Fields: dialog box select POSTALCODE and click OK.

7. Click on the comparison operator (set to = by default) and select the IS NOT NULL function and click OK. Click OK
to exit the Filter Rows properties dialog box.



& runctions: SR I=IE.

Select the function:
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Note: You will return to this step later and configure the Send true data to step and Send false data to

step settings after adding their target steps to your transformation.

8. Save your transformation.

Loading Your Data into a Relational Database (Table Output Step)

In this exercise you will take all records exiting the Filter rows step where the POSTALCODE was not null (the true
condition) and load them into a database table.

1.
2.

Under the Design tab, expand the contents of the Output node.
Click and drag a Table Output step into your transformation; create a hop between the Filter Missing Zips (Filter

Rows) and Table Output steps. Select Result is TRUE.

(=]
@—HE

Test file input

Double-click the Table Output step to open its edit properties dialog box.
Rename your Table Output Step to Write to Database.

Click New next to the Connection field. You must create a connection to the database.
The Database Connection dialog box appears.

Filter Mizsing Zips

B e —

Table @) Resultis FALSE
o] Main output of step

W Database Connection

Genesal ||

Advanced Connection Name:

Options

Pooing | Sample Data

Chustering Connection Type: [ Settngs
Frebird SQL <] | Host Mame:
Generic database | locahost
Gresnpium X
Gupta SOL Base Database Name:

| sampledata

Hypersonic .
1M DB2 Port Number:
Infobright | 9092
Informix User Name:
Ingres
Intersystems Cache sa
KingbaseES Passwiord:

LucilDB

MS ADcess il

SRl o520

Access:

x|

i Connection to database [Sample Data] & OK.

Hostname : localhost
Port 1 9092
Database name : sampledata

OK I

Test |eatureLst| Explore |

D gl ol P g, e N

6. Provide the settings for connecting to the database as shown in the table below.

‘M'\f‘v‘ﬁﬂw £ e Ay
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Connection Name

Type, Sample Data

Connection Type:

Choose, H2

Host Name

localhost

Database Name

Type sampledata

Port Number

9092

User Name sa

Password blank/no password

7. Click Test to make sure your entries are correct. A success message appears. Click OK.

Note: If you get an error when testing your connection, ensure that you have provided the correct settings
| information as described in the table and that the sample database is running. See Starting Pentaho Data
Integration for information about how to start the Data Integration Servers.
8. Click OK, to exit the Database Connections dialog box.

9. Type SALES DATA in the Target Table text field.
This table does not exist in the target database. In the next steps you will generate the Data Definition Language

(DDL) to create the table and execute it. DDL are the SQL commands that define the different structures in a
database such as CREATE TABLE.

10.In the Write to Database edit properties dialog box, enable the Truncate Table property.
11.Click SQL to generate the DDL for creating your target table.

12.Click Execute to run the SQL.
A results dialog box apperas indicating that one SQL statement was executed. Click OK close the execution dialog
box. Click Close to close the Simple SQL editor dialog box. Click OK to close the Table Output edit properties dialog
box.

13.Save your transformation.

You have been provided a second text file containing a list of cities, states, and postal codes that you will now use to
look up the postal codes for all of the records where they were missing (the ‘false’ branch of your Filter rows step).
First, you will use a Text file input step to read from the source file, next you will use a Stream lookup step to bring the
resolved Postal Codes into the stream.

1. Add a new Text File Input step to your transformation. In this step you will retrieve the records from your lookup file.
2. Rename your Text File input step to, Read Postal Codes.

3. Click Browse to locate the source file, Zipssortedbycitystate.csv, located at . . . \ desi gn-t ool s\ dat a-
i ntegration\sanpl es\transformations\files.

4. Click Add.
The path to the file appears under Selected Files.

Note: Click Show File Content to view the contents of the file. This file is comma (,) delimited, with an
| enclosure of quotation mark (“), and contains a single header row.

5. Under the Content tab, enable the Header option. Change the separator character to a comma (,). and confirm that
the enclosure setting is correct.

6. Under the Fields tab, click Get Fields to retrieve the data from your .csv file.

7. Click Preview Rows to make sure your entries are correct and click OK to exit the Text File input properties dialog
box.
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Stapname |resd Postsl Codes i
Fig | Content | Error Handing |Fiters M\H
£ + | Hame | Type | Format | Position | Length | Precson | Curency | Decimal | Grow |
1 CITY String 23 -
F STATE String ]
3 POSTALCODE Inbeger 5 o 5

ﬁl Examine preview data —

~Ioj
Rows of siep: Read Postal Codes (1000 rows) ‘
s« |cmy |stare | rostaicoce| '
1 ABBEVILLE AL 36310
2 ABBEVILLE L 510
3 ABBEVILLE M5 38501 i
4 AEBOT ME 03406
5 ARBOTT TH Tes21
& ABBYVILLE K5 67510
7 AEERCROMSIE WD 58001
B ABERDER Kr 42201
9 ABERDEEN M5 kLT
10 ABERDEEM OH 45101
. 11 ABERDEEN 50 57402
12 ABERDEFN PROVING GROUMD D 21005
-

13 ABERNATHY TS Tl

8. Save your transformation.

Resolving Missing Zip Code Information (Stream Lookup Step)

In this exercise, you will begin to resolve the missing zip codes.

1. Add a Stream Lookup step to your transformation. Under the Design tab, expand the Lookup folder and choose
Stream Lookup.

Draw a hop between the Filter Missing Zips (Filter rows) and Stream Lookup steps. Select the Result is FALSE.
Create a hop from the Read Postal Codes step (Text File input) to the Stream lookup step.

Double-click on the Stream lookup step to open its edit properties dialog box.

Rename Stream Lookup to Lookup Missing Zips.

Read Sales Data Filter Midsing Bps Write ta Database

a s DN

B

Read Postal Codes Laohkup Missing Zips

6. Select the Read Postal Codes (Text File input) as the Lookup step.

7. Define the CITY and STATE fields in the key(s) to look up the value(s) table. Click the drop down in the Field
column and select CITY. Then, click in the LookupField column and select CITY. Perform the same actions to
define the second key based on the STATE fields coming in on the source and lookup streams:

15 Stream Value Lookup P [m]
Stepname || aokup Mssng 2ios
Lockup step [Raad Postal Cades
The key{s) to look up the value(s):
2.+ |Feld |LockpFed | (

i CITY CITY
3 STATE STATE
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8. Click Get Lookup Fields. POSTALCODE is the only field you want to retrieve. (To delete the extra CITY and
STATE lines, right-click in the line and select Delete Selected Line.) Give POSTALCODE a new name of
ZIP_RESOLVED and make sure the Type is set to String. Click OK to close the Stream Lookup edit properties

dialog box.

Spacify the felds to retreys : __
& - | Field [ e name ] Default J Tyoe | .
i POSTALOODE IIP_RESOLVED String

Freserve memary (cosis CPU) &

Key and value are sxactly one nteger field [T ;

9. Save your transformation.

You can now select the Lookup Missing Zips step (Stream lookup ) in the graphical workspace. Right-click and
select Preview to display the preview/debugger dialog box. Click Quick Launch to preview the data flowing through
this step. Notice that the new field, ZIP_RESOLVED, has been added to the stream containing your resolved postal
codes.

Completing your Transformation (Select Values Step)

The last task is to clean up the field layout on your lookup stream so that it matches the format and layout of your other
stream going to the Write to Database (Table output) step. You will create a Select values step. This is a very useful
step for renaming fields on the stream, removing unnecessary fields, and more.

Add a Select Values step to your transformation. Expand the Transform folder and choose Select Values.

Create a hop between the Lookup Missing Zips and Select Values steps.

Double-click the Select Values step to open its properties dialog box.

Rename the Select Values step to, Prepare Field Layout.

Click Get fields to select to retrieve all fields and begin modifying the stream layout.

Select the ZIP_RESOLVED field in the Fields list and use <CTRL><UP> to move it just below the POSTALCODE
field (the one that still contains null values).

7. Select the old POSTALCODE field in the list (line 20) and delete it.

Select B Alter ~._Remove | Mata-data

o gk whPRE

Fislidname Rename to Length Priecision | Get fislds to select

8. The original POSTALCODE field was formatted as an 9-character string. You must modify your new field to match
the form. Click the Meta-Data tab.

9. In the first row of the Fields to alter table, click in the Fieldname column and select ZIP_RESOLVED.

10.Type POSTALCODE in the Rename to column; select String in the Type column, and type 9 in the Length column.
Click OK to exit the edit properties dialog box.

11.Draw a hop from the Prepare Field Layout (Select values) step to the Write to Database (Table output) step.
12.Save your transformation.
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Running Your Transformation

Pentaho Data Integration provides a number of deployment options depending on the needs of your ETL project in
terms of performance, batch load window, and so on. The three most common approaches are:

Local execution Allows you to execute a transformation or job from within
the Spoon design environment (on your local machine).
This is ideal for designing and testing transformations or
lightweight ETL activities

Execute remotely For more demanding ETL activities, consider setting up a
dedicated Enterprise Edition Data Integration Server and
using the Execute remotely option in the run dialog. The
Enterprise Edition Data Integration Server also enables
you to schedule execution in the future or on a recurring
basis.

Execute clustered For even greater scalability or as an option to reduce your
execution times, Pentaho Data Integration also supports
the notion of clustered execution allowing you to distribute
the load across a number of data integration servers.

This final part of the creating a transformation exercise focuses exclusively on the local execution option. For more
information on remote, clustered and other execution options review the links in the additional resources section later in
this guide or in the Pentaho Data Integration User Guide in the Pentaho InfoCenter.

1. In the Spoon graphical interface, click Run This Transformation.
The Execute a Transformation dialog box appears. You can run a transformation locally, remotely, or in a clustered
environment. For the purposes of this exercise, keep the default Local Execution.

2. Click Launch.
The transformation executes. Upon running the transformation, the Execution Results panel opens below the
graphical workspace.

Execution Results (]
% Execution Hstory | 4 Logging !’ Step Metrics ~| Perfarmance Gragh

2
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Migsng Zps ] 3813 0 0 0 0 0  Frished
21455 F (1] o} 0 0 0  Finished

Lﬂut o]

Read Postal Cades 0 0 21330 0 1 0 0  Fiished
Prepare Field Layout ) m 1] 0 ) 0 0 Finished
Walue Magper o 2B23

o 0 0 0 |F
] 1 0 o
o] 0 0 o
] [x] 1, 0 i}

2833 0

«..-..«..-..«..-..«..-..;
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The Step Metrics tab provides statistics for each step in your transformation including how many records were
read, written, caused an error, processing speed (rows per second) and more. If any of the steps caused the
transformation to fail, they would be highlighted in red as shown below.
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Execution Results

@ Execution Hstory . & Logging | f! Step Metrics ™. =] Performance Graph ’

z &
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5 Prepare Fiald Layout ] 0 1] L1} 1] L] 0 Stopped
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The Logging tab displays the logging details for the most recent execution of the transformation. Error lines are
highlighted in red.
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You can see that in this case the Lookup Missing Zips step caused an error because it attempted to lookup values
on a field called POSTALCODE2, which did not exist in the lookup stream.

The Execution History tab provides you access to the Step Metrics and log information from previous executions of
the transformation. This feature works only if you have configured your transformation to log to a database through
the Logging tab of the Transformation Settings dialog. For more information on configuring logging or viewing the
execution history, see the Pentaho Data Integration User Guide found in the Pentaho InfoCenter.

The Performance Graph allows you to analyze the performance of steps based on a variety of metrics including
how many records were read, written, caused an error, processing speed (rows per second) and more.

Execution Results =]
(% Execution History | &' Logging | #¥ Step Metrics ([~ Performance Graph

Metrics: LoadCustomer (Read) 4
Writhen -
Fead 800 1
Irgust = 3
Output S 4001
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3 30
n’ " .
§ o ¢
3

160 1 /
R o] /P-Ch. /’.} pao R A_/mnoo-0n J
TIAY Y = T, ke N

A | 1
Total run time is 76 seconds, 3 snapshiot is taken every 10 milliseconds
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Like the Execution History, this feature requires you to configure your transformation to log to a database through
the Logging tab of the Transformation Settings dialog box. For more information on configuring logging or
performance monitoring, see the Pentaho Data Integration User Guide found in the Pentaho InfoCenter.
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Creating Jobs

Jobs are used to coordinate ETL activities such as:

« Defining the flow and dependencies for what order transformations should be run

» Preparing for execution by checking conditions such as, "Is my source file available?," or "Does a table exist?"
« Performing bulk load database operations

« File Management such as posting or retrieving files using FTP, copying files and deleting files

« Sending success or failure notifications through email

For this exercise, imagine that an external system is responsible for placing your sales_data.csv input in its source
location every Saturday night at 9 p.m. You want to create a job that will check to see that the file has arrived and run
your transformation to load the records into the database. In a subsequent exercise, you will schedule the job to be run
every Sunday morning at 9 a.m.

1. Click & (New) in the upper left corner of the Spoon graphical interface.
2. Select Job from the list.
3. Expand the General folder and drag a Start job entry onto the graphical workspace..

& spoon - [Pentaho Enterprise Repository] Job 1 (changed) ?
Sch

Fie Edt View Acten Tools Help

_I _Iilil EI Perspectve: I“.uDea ribegr &tan

1y wiew [0 Dcwn Fu Getting Started Transformation o Jab1l %

Cteps b .l '&l -ﬂl_l I =

'S ﬂ ,
?;_:“1 =" > ¢
2 o
&' Set variables ’
r 4

L. ‘:j“ gl '-'“--«n-"‘"

The Start job entry defines where the execution will begin.
4. Expand the Conditions folder and add a File Exists job entry.
Draw a hop from the Start job entry to the File Exists job entry.

6. Double-click the File Exists job entry to open its edit properties dialog box. Click Browse and select the
sales_data.csv from the following location: ...\ desi gn-tool s\ dat a-i ntegration\sanpl es
\transformations\files.

Be sure to set the filter to CSV files to see the file.

o

= ransformations
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7. Expand the General folder and add a Transformation job entry.

8. Draw a hop between the File Exists and the Transformation job entries.

9. Double-click the Transformation job entry to open its edit properties dialog box.
10.Select the Specify by name and directory option. Click Browse.

11.Expand the repository tree to find your sample transformation. Select it and click OK. You likely have your
transformation stored under the "joe," (not public), folder.
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12.Save your transformation as Sample Job.

p—ao—F « X

START Fils Bt Getting Started Transfanmatior

13.Click Run Job. When the Execute a Job dialog box appears, choose Local Execution and click Launch.
»¥ Getting Started Transfarmation M\ i

& - [

START Fils Exizi Gatting Started Transformation
Execution results al
(& Hatwey | &' Logging
_Jab | Job Entry | comment | Resuit | Reason b
Bl Jb1 r
Jobz Job 1 Start of job exeoubon start r
START Start of job execution start i
START Jab execution finished Success
File Exists Start of job execubon Foligveed uncongibonal link
File Exists Job execution finished Success
Geting Started Trarsformation  Start of job exeoubon Foligveed link afier sucoess
Gatting Started Trarsformation  Job execution finished SuCCESs
Jab execution finished Success finighed

! .-i:f '-’ - r.""ﬁwwj\&

The Execution Results panel should open showing you the job metrics and log information for the job execution.
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Scheduling Jobs

The Enterprise Edition Pentaho Data Integration Server provides scheduling services allowing you to schedule the
execution of jobs and transformations in the future or on a recurring basis. In this example, you will create a schedule
that runs your Sample Job every Sunday morning at 9 o'clock.

1. Open your sample job.
2. In the menubar, go to Action -> Schedule.
The Schedule dialog box appears.

3. For the Start option, select the Date, click the calendar icon. When the calendar appears, choose the next Sunday.

Start
& Now

" Date: "'?“.-:-'.@
Time: I'.: 'I 00 'I AM -

4. Under the Repeat section, select the Weekly option. Enable the Sunday check box.
Repeat

|Run Once ﬂ

5. For the End date, select Date and then enter a date several weeks in the future using the calendar picker.

End
 MNoend

& Date: |o06/13/10 M
Time: 11 'I 59 "I PM =

6. Click OK to complete your schedule.

Note: The scheduler includes full support for Pentaho Data Integration's parameters, arguments, and
| variables. For more detailed information on scheduling options, please refer to the Pentaho Data Integration
User Guide found in the Pentaho InfoCenter.

7. To view, edit and manage all scheduled activities, click the Schedule perspective on the main toolbar. Here you can
view a list of all schedules along with information such as when the next scheduled run will take place, when the last
run took place and its duration and who scheduled the activity.

Perspective: | & Dara Integraton (8 Model | ) mmem

& Spoon - [Pentaho Enterprise Repository] Sample Job v1.2 _|o] %
Fle Edt View /ctor Took Help

B glR|E| =) perspective: [ Data Integration | Model | ™ visuaize [ 4 schedule

o/ »lw] 5] 2|8 ¢
hame [Type  [state [ mextRun [ Last Run (duration) [ sched... |
Sample Job:1269873434828 | job NORMAL  Sun Apr 04 12:00... Jjoe
Al A B P e e ol i

8. If the scheduler is stopped, you must click Start Scheduler on the sub-toolbar. If the button appears with a red stop
icon, the scheduler is already running. Your scheduled activity will take place as indicated at the Next Run time.
Fla Edit Wew Acton Tools  Helf

'_5']‘ & EE @ Perspective: Dam]ntegramn|EMDdH|:\n'suabﬂe & Schedule )

3| »|=| 5G|
Name [Type |[state | nextRun | Last Run (durati... | Sched...
Sample Job: 1269873434828 job NORM... Sun Apr 04 12:0... Joe

Ldh . - N e g g -m...&.f

Note: You can also start and stop individual schedules by selecting them in the table and using the Start and
Ll Stop buttons ®| &l on the sub-toolbar.
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Historically, starting new Business Intelligence projects required careful consideration of a broad set of factors including:
Data Considerations

e Where is my data coming from?
*  Where will it be stored?
« What cleansing and enrichment is necessary to address the business needs?

Information Delivery Consideration

« Will information be delivered through static content like pre-canned reports and dashboards?
» Will users need the ability to build their own reports or perform interactive analysis on the data?

Skill Set Considerations

« If users need self-service reporting and analysis, what skill sets do you expect them to have?

« Assuming the project involves some combination of ETL, content creation for reports and dashboards, and meta-
data modeling to enable business users to create their own content, do we have all the tools and skill sets to build
the solution in a timely fashion?

Cost

* How many tools and from how many vendors will it take to implement the total solution?

« If expanding the use of a Bl tool already in house, what are the additional licensing costs associated with rolling it out
to a new user community?

« What are the costs in both time and money to train up on all tools necessary to roll out the solution?

« How long is the project going to take and when will we start seeing some ROI?

Because of this, many new projects are scratched before they even begin. Pentaho’s Agile Bl initiative seeks to break
down the barriers to expanding your use of Business Intelligence through an iterative approach to scoping, prototyping,
and building complete BI solutions. It is an approach that centers on the business needs first, empowers the business
users to get involved at every phase of development, and prevents projects from going completely off track from the
original business goals.

In support of the Agile Bl methodology, the Spoon design environment provides an integrated design environment for
performing all tasks related to building a Bl solution including ETL, reporting and OLAP metadata modeling and end
user visualization. In a single click, Business users will instantly be able to start interacting with data, building reports
with zero knowledge of SQL or MDX, and work hand in hand with solution architects to refine the solution.

This exercise builds upon your sample transformation and highlights the power an integrated design environment can
provide for building solutions using Agile BI.

For this example, your business users have asked to see what the top 10 countries are based on sales. Furthermore,
they want the data broken down by deal size where small deals are those less than $3,000, medium sized deals are
between $3,000 and $7,000, and large deals are over $7,000.

1. Open or select the tab containing the sample transformation you just created.

2. Right-click the Write to Database (Table Output) step, and select Visualize -> Analyzer.
In the background, Pentaho Data Integration automatically generates the OLAP model that allows you to begin
interacting immediately with your new data source.

3. Drag the COUNTRY field from the Field list on the left onto the report.
4. Drag the SALES measure from the Field list onto the report.
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[ —
© Unsaved Report

o No Filter in use XML | Log | Clear Cache w¥vour report is read

(countRY | SALES
Australia 630,623

Austna
Belgium
Canada
Denmark
Finland
France
Germany
Irsland
Italy

Japan
Norway
Fhilipgines
Singapore
Spain
Sweden
Switzerland
(¥

POnked States

USA

Note: Immediately you can see that there is another problem with the quality of the data. Some records
| being loaded into the database have a COUNTRY value of United States, while others have a value of USA.
In the next steps, you will return to the Data Integrationperspective to resolve this issue.

Correcting the Data Quality Issue

Follow the instructions below to correct the data quality issue:

1. Click on the Data Integration perspective in the main toolbar.

Perspective: | &1 Data Integration

2. Right-click the Table output step from the flow and choose Detach step. Repeat this process to detach the second
hop.

Expand the Transform folder in the Design Palette and add a Value Mapper step to the transformation.

Draw a hop from the Filter Missing Zips (Filter rows) step to the Value Mapper step and select Result is TRUE.
Draw a hop from the Prepare Field Layout (Select values) step to the Value Mapper step.

Draw a hop from the Value Mapper step to the Write to Database (Table output) step. Your transformation should
look like the sample below:

o 0k w

e . |

Read Sales Data Filter Migsing Zips /gue Mapper \Write to Database
— =*

o
=1 =
3
/ge Field Layout
B o
1l

Read Postal Codes Lookup Missing Zips
7. Double-click on the Value Mapper step to open its edit step properties dialog box.
8. Select the COUNTRY field in the Fieldname to use input.

9. In the first row of the Field Values table, type United States as the Source value and USA as the Target value.
Click OK to exit the dialog box.

[=A b
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“? Value Mapper

Stepname : | yalye Mapper
Fieldname to use : | COUNTRY
Target field name (smpty=overwrite) :

Default upon non-matching :

Aoy

Field values:
i ~ | Source value Target value
1 United States  US
10.Save and run the transformation.
11.Click Visualize in the main toolbar.
12.Click the Clear Cache link at the top of the report.
13.Click Refresh under the data section of the Visualization Properties panel and notice that the data has been

cleansed.
| I
© Unsaved Report view As: |||+ Model
off MNoFilterinuse XML | Loa %Your report is ready. Rews: 19 Celumns: 1 e
| Clear Model 12 Cube
Cache
|
[ counTry SALES
Data
I.\lu:traha 630,623 | i
| Austria 202,063 souress
| Belgium 108,413 | N
| canada 224,079 |
| Denmark 245,637 | 4
Finland 326,562 -
| France 1,110,917 |
| Germany 220,472 |
| Ireland 57,756 |
| Italy 374,674
| Japan 188,168 |
[ MNorway 307,464 |
| Philippines 54,016
I Singapore 288,488 |
| Spain 1,215,687
Sweden 210,014 |
' Switzerland 117,714
| ey
| Usa 3,627,983

Creating a Top Ten Countries by Sales Chart

Follow the instructions below to create the top ten countries by sales chart:

1. Right-click the COUNTRY header and select Top 10, and so on.

2. Confirm that the default settings are set to return the Top 10 COUNTRY members by the SALES measure. Click
OK.

3. Click Chart and select Stacked Bar to change the visualization to a bar chart.
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) Spoon - [EE Repository] Sample Transformation v1.10 -y
Ble Edt Yew Took Heln =
2 SRR O Perspective: [ Data Integraton [] Model | ™) viwaize | 1) Scheduie

af ETVO00 OK B
I

Available figlds (33) for: 1'% i l
Model 12 Cube ) © Unsaved Report e |
Pc ] vigw | 4 2 Filarin use XML | Leg | Clear Cache wfvour repart is ready. | :ﬂ: —
* Number o] SALES
HeNTH 1D 0 1,000,000 2,000,000 000,000
MERP . “ s A - i
CRDERLINENUMEER Sourem:
actam o . e
FRICEEACH
QUANTITYORCERED .
SALES %
YEAR 1D i
* Text {Names, Categories, stc.)
ADDRESSLINED 4
ADDRESSLINEZ
cr
CONTACTFIRSTHAME
CONTACTLASTNAME
COUNTRY
CUSTOMERNAME
MONTH ID E
MERP
CROERDATE
CRDERLINENUMBER .
CROERNUMBER .
FHONE
FOSTALCODE |

Breaking Down Your Chart by Deal Size

Your source data does not contain an attribute for Deal Size, so you will use the Data Integration perspective to add
the new field.
1. Click Data Integration in the main toolbar.

2. Expand the Transform folder and drag a Number Range step onto the graphical workspace between the Value
Mapper step and the Write to Database (Table Output) step. Click Yes to split the hop.

E a)

‘alue Mapper Mumber range Write to Database

Double-click Number range to open its edit properties dialog box.

Choose the SALES field as your Input field.

Type DEAL SIZE as the name for the Output field.

In the Ranges table, define number ranges as shown in the example below. Click OK.

o g s w

Mumber ranges _|og
Step name: I Number range
Input field: |5m_55
output fied: | DEALSIZE
Defautt value(f no range | unknown
Ranges (min == x= max):
#~ | Lower Bound | Upper Bound |value |
i 3000.0 Smil ¥
2 3000.0 F000.0 Medium
5 7000.0 Larce

‘m',-..l-u“”"“

Note: Because this step will be adding new field into the stream, you must update your target database table
to add the new column in the next steps.
7. Double-click on the Write to Database (Table output) step.
8. Click SQL to generate the DDL necessary to update the target table.

9. Click Execute to run the SQL. Click OK to close the results dialog box. Click Close to exit the Simple SQL Editor
dialog box. Click OK to close the edit step properties dialog.
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10.Save and run your transformation to re-populate your target database.

—{=a——)

Number range Witz to Database

Read Postal Codes Lookup Missing Zips

Wrapping it Up

Follow the instructions below to complete your Agile Bl exercise:

1. Click Visualize to return to your Top 10 Countries chart. Next, you will update your dimensional model with the new
Deal Size attribute.

2. Click View in the Visualization Properties panel on the right to display the Model perspective and begin editing the
model used to build your chart.

3. Drag the DEALSIZE field from the list of available fields on the left onto the Dimensions folder in the Model panel
in the middle. This adds a new dimension called DEALSIZE with a single default hierarchy and level of the same

name.
Available: s EE 2 s v aB@
ADDRESSLINE1 = [ Model ~
é?;—nftzss"” =3 Measures
CONTACTFIRSTHAME ol MONTH ID
CONTACTLASTNAME oIn MsRP
COUNTRY R
ORDERLINENUMBER
CUSTOMERNAME i LINEN, BE
DEALSIZE uln CROERNUMEER
MONTH ID alll PRICEEACH
I e
ORDERLINENUMSER o8 QUANTITYORDERED
ORDERNUMBER alle saLEs
33‘35 CODE el YEAR D
STAL E =
PRICEEACH O eain
PRODUCTCODE = 12 peaLsize
PRODUCTLINE = gh, DEALSIZE
QR ID o "
QUANTITYORDERED R, oeasize
AL L A TS CORERIINEL o o csre e s

Click Save on the main toolbar to save your updated model. Click Visualize to return to your Top 10 Countries chart.
Click Refresh to update your field list to include the new DEALSIZE attribute.

Click Toggle Layout to open the Layout panel.

Drag DEALSIZE from the field list on the left into the Color Stack section of the Layout panel.

Click Toggle Layout to close the Layout Panel. You have successfully delivered your business user’s request

© N o g s
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4 1 Filter in use XML | Log | Clear Cache ##Your report is ready. ;
SALES 3
l.l 1,““!.“““ z,mq,m 3,0“3,0“0

M Large




| Pentaho Data Integration and Big Data | 38

PDI works with a broad spectrum of Big Data sources including Hadoop (HDFS), NoSQL databases, and other high-
performance analytic databases.

Pentaho Big Data components are open source in order to better function within the Hadoop open source ecosystem.
Pentaho has put all of the Hadoop and NoSQL components into open source to make Kettle be the best and most
pervasive ETL engine in the Big Data space.

To further Kettle adoption within the Hadoop community, Pentaho decided to move the Kettle open source license
from GNU Lesser General Public License (LGPL) to the more permissive Apache license. This addresses issues of
restrictions applied to a derivative work based on combining Kettle with Hadoop.

The Pentaho Data Integration (Kettle) client comes pre-configured for Apache Hadoop 0.20.2. If you are using this
distribution and version, no further configuration is required after downloading and extracting Kettle.

To configure Kettle for a different version of Hadoop, you first should delete the core JAR file in $PDI _HOVE/ | i bext/
pent aho, and replace it with the JAR file from your cluster.

For example, if you are using Cloudera CDHu2, you would copy $HADOOP_HOVE/ hadoop- cor e- 0. 20. 2-
cdh3u2. j ar to $PDI _HOVE/ | i bext / pent aho

For certain Hadoop distributions or versions, for example Hadoop 0.20.205, you also need to have Apache Commons
Configuration included in your set of PDI libraries. To do this, copy conmons- confi guration-1.7.jar to
$PDI _HOVE/ | i bext / conrmons.

For other Hadoop distributions or versions, for example Cloudera CDH3 Update 3, you also need to copy the JAR file
$HADOOP_HOVE/ | i b/ guava-r09-j arjar.jar to $PRD _HOVE/ | i b.

In this guide you will learn how to copy local files into HDFS using PDI's graphical design tool, Spoon. You can use this
tool to put files into the HDFS from many different sources.

In order to follow this guide you should already have Hadoop and Pentaho Data Integration, and both tools should be
running.

Create a job to load files into HDFS using these steps:

1. Create a new Job: Select Fi | e -> New-> Job from the menu toolbar, or click the New File icon, then select Job.

2. Add a Start step: Find the Start step within the Design Palette underthe General section. Drag it to the Job Canvas.

3. Add a Hadoop Copy Files step: Find the Hadoop Copy Files step within the Design Palette, under the Big Data
section. Drag the job entry onto the Job Canvas.

4. Connect the Start and Copy Files Job Entries: Hover the mouse over the Start step and a tooltip will appear. Click
on the output connector (the green arrow pointing to the right), then drag the connector arrow to the Hadoop Copy
Files step.

5. Edit the Copy Files Job Entry: Double-click the Hadoop Copy Files step to edit its properties. Next, enter the
following information:

a) Fil e/ Fol der source(s)

b) Fi |l e/ Fol der destination(s)

c) Wldcard (RegExp)

d) Click the Add button to add the above entries to the list of files to copy.

e) Checkthe Create destination fol der option to ensure the weblogs folder is created in HDFS the first time
the job is executed.

f) Click OK to close the window.

6. Save the Job: Choose Fi | e -> Save as... from the menu, then save the transformation.
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Run the Job: Choose Act i on -> Run from the menu (or click on the green run button on the Job Toolbar). An
Execut e a j ob window will open. Click on the Launch button. An Execut i on Resul t s panel will open at the
bottom of the PDI window and it will show you the progress of the job as it runs. After a few seconds the job should
finish successfully. Results can be viewed in the Job netri cs tab. If there were errors, the job step that failed will
be highlighted in red, and you can read error messages in the Loggi ng tab.

Check Hadoop: Run the following command:hadoop fs -1s /user/pdi/[fil enane]
-rwxrwxrwx 3 demo demo 77908174 2011-12-28 07:16 /user/pdi/[filename]

These instructions are specific to the MapR distribution of Hadoop.

Overview:

1.
2.
3.

The MapR native libraries for your architecture must be added to the j ava. | i brary. pat h.
MapR Hadoop Configuration directory needs to be on the classpath.
MapR Hadoop Core library must be on the classpath.

The following are PDI client configuration instructions for MapR:

1.

For all architectures:

a) Update the $PDI _HOVE/ | auncher /| auncher. pr operti es with the attached launcher.properties

b) Delete $PDI _HOVE/ | i bext / pent aho/ hadoop- 0. 20. 2-core. j ar.

c) Copy $SMAPR_HOVE/ hadoop/ hadoop- 0. 20. 2/ | i b/ hadoop- 0. 20. 2- dev-core. j ar into $PDI _ HOVE/
I i bext/ bi gdat a.

d) Copy $SMAPR_HOVE/ hadoop/ hadoop- 0. 20. 2/ 1i b/ maprfs-0. 1. j ar into $PDI _HOVE/ | i bext / bi gdat a.

For Linux x64 systemns:

a) Update the $PDI _HOVE/ spoon. sh with the attached spoon.sh

b) Update the $PDI _HOVE/ pan. sh with the attached pan.sh

c) Update the $PDI _ HOVE/ ki t chen. sh with the attached kitchen.sh

d) Update the $PDI _HOVE/ cart e. sh with the attached carte.sh

For Mac OS X 64-bit systens:

a) Update the Data Integration 64- bi t . app/ Cont ent/ | nf 0. pl i st with the attached Info.plist

The following are PRD configuration instructions for MapR:

1.

Delete $PRD_HOME/lib/jdbc/hadoop-0.20.2-core.jar

2. Copy SMAPR_HOME/hadoop/hadoop-0.20.2/lib/hadoop-0.20.2-dev-core.jar into SPRD_HOME/lib
3.
4. For Linux x64:

Copy SMAPR_HOME/hadoop/hadoop-0.20.2/lib/maprfs-0.1.jar into $PRD_HOME/lib

a) Add - Dj ava. | i brary. pat h=/ opt/ mapr/ hadoop/ hadoop- 0. 20. 2/ | i b/ nati ve/ Li nux- and64- 64 to
the last line in $PRD_HOVE/ r eport - desi gner . sh.

For MacGCs:

a) Add - Dj ava. |l ibrary. pat h=/ opt/ mapr/ hadoop/ hadoop- 0. 20. 2/ 1 i b/ native/ Mac_OS X-x86_64- 64
to the VMOptions entry in $PRD_HOVE/ Pent aho\ Repor t \ Desi gner . app/ Cont ent s/ I nf 0. pl i st
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Enterprise Edition enables you to deploy Pentaho Data Integration with confidence, security, and far lower total cost
of ownership than proprietary and open source alternatives. Benefits of Pentaho Data Integration Enterprise Edition
include:

« Live support provided by a knowledgeable team of product experts that consistently rates higher in customer
satisfaction than the Bl megavendors

« Dedicated customer case triage providing faster response times and increased priority for customer reported defects
and enhancements

« Enterprise security with granular control over content and actions that can be performed by users and roles.
Enterprise security can be managed directly in Pentaho Data Integration Enterprise Edition or configured to integrate
with your existing LDAP or Active Directory implementation

« Centralized content management facilitating team collaboration including secured sharing of content, content
versioning (revision history), and transformation and job locking

* Integrated scheduler allowing you to schedule job and transformations for future or recurring execution; schedules
are created and managed directly in the easy-to-use, graphical designer (Spoon)

« Additional transformation steps and job entries for integrating with third-party applications, messaging architectures
and more

« All certified software releases go through rigorous quality testing and a managed release process to ensure the
stability of your production deployments

e Only subscription customers get access to maintenance releases containing critical defect resolutions

Note: Binary distributions of Community Editions are provided with major product releases only. If you have a
| critical defect or improvement that has been addressed as part of a minor or patch release, you must wait for
and upgrade to the next major release of Pentaho Data Integration.

Pricing for Pentaho Data Integration Enterprise Edition can be found at http://www.pentaho.com/explore/how-to-buy/.
For more information or to start your subscription today, contact us at http://www.pentaho.com/contact/.


http://www.pentaho.com/explore/how-to-buy/
http://www.pentaho.com/contact/
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Troubleshooting

This section contains known problems and solutions relating to the procedures covered in this guide.

| don't know what the default login is for the DI Server, Enterprise Console, and/or
Carte

For the DI Server administrator, it's username admin and password secret.

For Enterprise Console administrator, it's username admin and password password.
For Carte, it's username cluster and password cluster.

Be sure to change these to new values in your production environment.

Note: DI Server users are not the same as Bl Server users.
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